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Quick Start Instructions 

 

Getting Started 

NOTE: As of June 2012 the Windows Installer has an older DanteR version (0.1.1) than 

0.2 on it. For the latest version please install from the zipped binary linked from 

http://omics.pnl.gov/software. We apologize for the inconvenience. 

 

Mac and Linux 

 

1. Install R (www.r-project.org) 

(Mac Only) Install GTK+ 2.18.5 framework for Mac from http://r.research.att.com/   

(Linux Only) Install xclip and xsel 

2. Follow the instructions at http://omics.pnl.gov/software to install DanteR 

3. To run DanteR, open the terminal (Terminal in Mac),  start R and type:  

  library(DanteR); dante() 

 

 

 

 
 

Installation from CRAN 

 

NOTE: As of June 2012 the updated version of DanteR has been submitted to CRAN. 

Should that not be on-line at the time of reading, for the latest version please install from 

the binary linked from http://omics.pnl.gov/software. We apologize for the 

inconvenience. 

 

More R savvy users may install DanteR in the usual way from CRAN. In R type 

http://omics.pnl.gov/software
http://omics.pnl.gov/software


 

install.packages(DanteR) 

 

which will start the automatic installation process. DanteR can be started by typing the 

command 

 

dante()  

 

These 3 procedures should allow you to go through the installation in Windows Mac and 

Linux respectively. 

We will explore loading, manipulation and exploration of an example proteomics dataset 

in the next few pages. A genomics dataset would present similar issues, although some 

protein-level procedures would not be necessary. 

 

To quit DanteR, use File-Quit. You can choose whether you want to close your R session 

or not. 

 

Online help is available via the Help menu or on the PNNL website at omics.pnl.gov. The 

examples used for commands are executable and displayed in the command line display, 

so they can be saved, edited, and re-run. 

 

The example in the data set contains (real) data from a proteomic experiment containing 

several thousand peptides over 40 experiments.  

 

Anatomy of the DanteR front-end 

 

The DanteR window shows the usual windows menu, icons, an object browser, and a 

tabbed history window. 

 

 
 

 



Object Browser 

 

The Object browser shows current data objects. 

 

 
 

Within the Object Browser, Filter By lets you choose data sets, functions, or saved plots. 

Right click for context menu on an item, and Show Item brings it into the table viewer. 

The context menu also has Save, Rename, Copy, Delete functions. 

 

Within the History Tab, this logs all the executed DanteR commands and can open, save 

and close them as *.R files. It can edit the commands on the window to replay or run 

loops. For example, highlight a command and click “Run Selected” to re-run 

 

The History display also opens new tabs for a Table display. 

 
 

Clicking on data table items within the object browser will load them into a spreadsheet 

display in the window. This is similar to other editable spreadsheets (with the exception 



of being entirely R-based!) – and right-clicking on cells, rows, and columns will bring up 

context menus. First column are row names, and the top corner is data set name. Editing 

can be done as normal, and Ctrl-Z allows undo (although coercion of data may be 

irreversible; see the RGtk2Extras help file), and the help for ?dfedit. 

 

Data import and export from the spreadsheet can be done quite simply with the familiar 

Ctrl-A, Ctrl-C and Ctrl-V (or right-click context menu) copy and paste, although in Linux 

this requires xclip and xsel to be installed. 

 

Right click on column headers for setting the column type – numeric, factor, and so on. 

This also allows Insert, Delete, Copy column and Rename of Column header. You can 

right click on corner for copy/paste of entire table – useful for Excel, and right click on 

tab to remove table. 

 

Note that all data is displayed with a completely blank row at the bottom, to allow 

appending data. For numeric data, this will appear as a row of NA. 

 

In general, DanteR menu dialogs show functions accessed via dialogs and menus which 

try to give their output sensible names. For example,  performing ANOVA on a table 

called MyData automatically produces a table called ANOVA_MyData. If you want to 

do ANOVA again in a different way and want to keep the old ANOVA_MyData, right-

click and rename the old table to something else. 

 

Importing Data 

 

DanteR is based on a data/metadata/model. Data is kept in crosstabs (rows are peptides, 

columns are experiments). We keep track of data in crosstabs by linking data tables to 

row and column metadata tables via row and column names. Factors or Column metadata 

(information about datasets) are treatment, condition, replicates, etc while Row metadata 

could contain peptide mass tag ID’s, protein ID’s, etc. 

 

DanteR can preserve the peptide-protein mapping information if the user decides to load 

protein information. The data file can be csv, tab delimited txt,  Excel or SQLite format 

and has:  A header row, an optional unique row ID column (ex: Mass Tag or Probeset ID) 

and abundance values for each row in the next columns with each column corresponding 

to a dataset . More optional columns containing protein IDs or other information about 

rows is allowed and this will create a separate table with peptide <-> protein relations 

(row metadata).  Any other information can go in further optional columns. 

 

Note: for Linux at this time, Excel file import is disabled, but we recommend Excel files 

be saved as csv (comma separated) format for importing. 

 

File import 

 

In this vignette, we will show how to open and import a standard proteomics data file. 

The file 'SampleData4DanteR.csv' can be found on the PNNL website at omics.pnl.gov. 



 

Opening it is a 2 step process. Go to File->Import SQL/CSV/XLS and select the file in 

the first dialog. The file type is automatically assigned from the suffix and we assume 

that txt files are tab delimited text with column names. For Excel, SQLite files the 

worksheet or table can be selected. 

 

Step 1 

 
 

A second dialog will come up that allows the user to tell DanteR which columns should 

be imported into the data table. DanteR allows selection of particular columns for 

numerical data, data about rows of data (row metadata) and data about data columns 

(column metadata/factors). To get numeric data into DanteR, check “Data Crosstab”. 

Columns containing relevant data should be selected from the data table in "All 

Columns". Select and move the numeric columns in the data table from “All Columns” 

into “Columns to Include”. The Table Name field should be kept short. We also want to 

have a unique row identifier - either a unique peptide or gene ID.  

 

If a column containing a unique identifier exists, set “Data Row ID” to the unique row 

index (i.e. Mass Tag ID for proteomics data, gene or spot ID for genomic data or peptide 

sequence). If the data table doesn't have a unique row identifier, choosing 'Row Numbers' 

will index each of N rows by the numbers 1...N.  

 

For the example data set, select all but the first data column (CTR_ onwards) and place 

them into Columns To Include. 

 

Row Metadata 

If there is row metadata - that is, information about rows such as pathways or family 

groups corresponding to genes, proteins corresponding to peptides, protein functional 

families etc, place the row information (proteins, pathways etc) into Row Metadata 

Columns from All Columns.  

 

For the example data set, select Mass_Tag_ID as the unique row ID and move 

MinOfORF into the Row Metadata Columns field. 

 

Column Metadata 

Frequently "factor data" - information on the structure of related experiments needs to be 

imported. DanteR provides several ways to do this. Factor data can be imported as a table 

from Import Table, using the "Column Metadata" option. In this case, the format of the 



data needs to be a table with one column containing column names of a corresponding 

data table, which can be imported before or after this data table has been imported.  

 

Alternatively, many scientists may give their experiments meaningful names which 

reflect the factor structure. In this case, DanteR can save time by automatically turning 

the experiment names into a table of column metadata/factors at the same time the data 

table is imported. Using the "Guess Factors Table from Column Headers" option - the 

program will attempt to split the names of your experiments (columns) into different 

groups based on common text separators including space, underscore, hyphen and 

number-letter boundaries, and create and link a corresponding factor table. This can be 

useful since experimenters often give their experiments names that fall in this pattern, e.g. 

Experiment_1_Condition_A, Experiment_2_Condition_B.  

 

Finally, Metadata->Create Factors allows user interactive creation of factor tables 

corresponding to a data set - see the Help file. 

 

For the example data set, check this box, then click OK to import and create data and 

metadata tables. 

 

 

 
 

Final Step 

 

To save space DanteR will remove redundant information when you load data. This 

means data rows with duplicated unique ID’s are removed. A “Data Loading 

Information” message summarizes the input and output data table sizes. If non-identical 

rows are removed with identical row ID's the program will warn the user, this is to act as 

a check the user has imported the data as intended. 

 

The user should verify the size of the data table is as expected. For the example data set, 

the final size of T_Data should be 2381 rows x 39 columns and T_Row_Metadata should 

be 2769 rows x 2 columns. Notice that 388 rows with identical Mass_Tag_ID key are 

removed, but no information is lost. 

 



 
 

Tables T_Data, T_Row_Metadata and T_Column_Metadata should be visible in the 

Object Browser. 

 

Note: Sometimes the object browser does not refresh , but the user can always manually 

refresh by opening the "Filter by" choice, we hope to correct this shortly. The front-end 

DanteR window can be closed without closing the R session and restarting it may help. 

 

Setting Up Factors/Metadata 

 

When a data table is loaded with associated row and column factors, or metadata, DanteR 

will create a link between these tables to allow the program to keep track of these 

associations. The link consists of a key name-table name pair. In our example, the 

factor/column metadata table contains a field called 'Dataset' which corresponds to the 

column names of T_Data.  

 

Internally, to keep track of this relationship, T_Data is set to have an attribute with 

properties (table = 'T_Column_Metadata', key='Dataset'). This works similarly for row 

metadata. The key always needs to correspond to a field name in the metadata table 

which contains all of the row or column names. Generally the user will not have to worry 

about this, it is all done 'behind the scenes'. 

 

Moreover, when particular actions are done to the data, DanteR will maintain the link 

between the output of the functions and the row/column metadata. For example, it might 

be desirable to create a boxplot of experiment intensities colored by a treatment group 

across replicates. DanteR's metadata tracking mechanism will allow this to be done for 

both the original data and log-transformed data (say). 

 

The concept is shown below: 

 



 
 

Checking Data Links To Metadata 

 

The links between data tables and their metadata can be checked by going to Metadata -> 

Link To Metadata and selecting the main data table. The row and column metadata 

tables, and the keys which link them to the row and column names of the data table, will 

be shown. 

 



 
 

For the example data set, select the data table and check it contains linked row and 

column metadata tables. The Key choice fields will automatically populate – if they’re 

blank, the links are broken. Hit “OK” to create the link.  

 

If you have manually loaded in a data table and want to link manually loaded or created 

row and column metadata tables, you will need to use this function to add row and 

column metadata to a data table. When you select the data table, check "Link 

Row/Column Metadata" and select the metadata table, DanteR will try to automatically 

populate the Key choice fields. Hitting "OK" will create the link(s). 



 

Metadata/Plot All Links 

 

 

 
 

To see all the data tables which are linked to row and column metadata tables at once, 

select your row and column metadata tables (it should default to their names). The 

function goes through all linked tables and plots how they are linked, highlighting 

problems. Note: The graphical layout does not yet work well for large numbers of linked 

data tables. 

 

 

 
 

M a s s . T a g . I D 

M a s s . T a g . I D D a t a _ C o l u m n 

D a t a _ C o l u m n 

T_Row_Metadata LogT_T_Data 

T_Data T_Column_Metadata 



 

After loading T_Data and creating row and column metadata, we can explore basic data 

transformation and plotting. 

 

Opening and Saving Session Files 

 

R sessions contain all the objects you are working with. Save your sessions often. If you 

load a session containing MyDataTable and MyDataTable exists in your current R 

session, it will get written over. DanteR can load previous old-version DAnTE sessions 

(.dnt) or R sessions (.RData files).  If you load an old-version DAnTE session, DanteR 

will convert table names and formatting so they’re compatible. Save Session saves the 

current session silently, Save As renames it. 

 

For the example data set, you can use File->Save Session to save your session as 

"MySession.RData", which can then be loaded again if desired. Sessions are cross-

platform compatible. 

 

File/Close Workspace 

 

This function will remove everything in the workspace and close any open tables in the 

viewer. 



 

Exporting Tables 

 

 
 

The File/Export Tables function will export tables in your session to supported formats. 

Select the tables you want to export. If you have selected SQLite, Excel 2007, Excel and 

Access, individual tables will save as sheets within the exported file. CSV and TXT will 

save as separate multiple files. For CSV/TXT, files are named 

<filename>_<tablename>.<extension> 

 

For the example data set, you can export T_Data and T_Column_Metadata to separate 

CSV files using this method. 

 

However, it is often even easier simply to copy and paste the data of interest directly 

from DanteR's built-in spreadsheet data viewer into another spreadsheet via the usual 

Ctrl-A, Ctrl-C, Ctrl-V combinations, or right-clicking on the data viewer to copy data (or 

Cmd-A, Cmd-C, Cmd-V for Mac systems). Data can be copied and pasted with row and 

column names (Ctrl-Shift-C) or without (Ctrl-C). 

 

Viewing Data 



 

By double clicking on a data table in the Object Browser you can view and edit it in the 

data display. A new tab will appear. 

 

The data viewer has a large set of commands for editing associated with it and this can be 

accessed via Help/RGtk2Extras menu.  

 

For the example data set, clicking on T_Column_Metadata will show the factors/column 

metadata table. Notice the column names are set to defaults A, B, C... in absence of other 

information. You can rename them to something more meaningful (factor names) by 

opening them in the table viewer, right-clicking on the column headers and then using the 

Rename Column option. 

 

The data type is important in R. Numeric data must be set to a numeric type. This should 

be automatic for most data sets. 

 

Pre-Processing Data using Transformation 

 

For the example data set, highlight T_Data in the object browser by right-clicking it once. 

This will prompt the program to pre-fill DanteR function dialogs with the T_Data table as 

a source data set. 

 

Select Pre-Process/Data Transformation for the standard transformation dialog, which 

gives the option to perform log transformation and apply a constant multiplier and 

addition correction. T_Data should be pre-filled in "Dataset". Click "OK" with the 

defaults checked to perform a log2-transformation of T_Data. 

 

A new data set should be created called LogTransform_TData.  

 

 



 

This behavior is typical of how DanteR dialogs work to allow user access to functions 

written in R: the program attempts to give the outputted data table a meaningful name. 

The user may wish to rename the data to something shorter (via right-click context menu 

in the object browser). 

 

Plotting data 

 

For the example data set, we'll show how to perform a typical plotting function in R - a 

boxplot. Highlight T_Data to pre-fill it in the dialog, then click Plot/Boxplots to bring up 

the box plots dialog. 

 

Move the data columns you wish to plot into "Selected Data Columns" and choose one of 

the columns in "Color by Factor". Then "OK" to create the plot. DanteR automatically 

selects a high-contrast combination of colors. The size of the scale and box width, and 

whether to show outlying points, can be seen. Optionally, the X- and Y- axis limits of the 

plot can be set. Clicking "OK" will show the plot in a new window. Note that the plot 

dialog will stay open to allow the user to adjust plotting parameters. 

 

Plots can be resized, exported to powerpoint as metafiles, saved as pdf, etc. by right-

clicking on them. Most of DanteR's plot functions also save their output as an R object 

(accessible via the Object browser/Filter By saved plots). Click “Show” or double click to 

reopen the plot and rename plots to avoid them being overwritten if they are re-run. 



 
 

For the example data set, now close the plot window, highlight the 

LogTransform_T_Data set, and perform Plots->BoxPlots for this data set. Notice that you 

can still choose factors to color by, because the log-transformed data table kept the 

column metadata association of its parent data table (see previous section on metadata).  

 

For the example data set, notice that log-transformed data sets appear to be more 

symmetrically distributed. We can also discern systematic differences based on the 

treatment group. DanteR has many other plotting functions, such as histograms, 

heatmaps, quantile-quantile (Q-Q) plots to check normality, but they all work in a similar 

way. In the next section, we'll perform data normalization to remove confounding 

systematic differences between data sets. 

 

 



Normalizing Data using Linear Regression 

 

 
 

It quite often happens that large scale biological data contains a systematic bias which 

depends on the identity of the data set. For example, in LC-MS proteomic data, the 

sensitivity and ion efficiency depends on the geometry of the ESI spray tip, which may 

change from run to run. For another example, a bi-color microarray may contain an 

intensity-dependent bias due to dye saturation effects. Quite a lot has been written about 

this phemenon (Quackenbush, 2002), and DanteR offers ways to correct for it using 

either simple linear regression, eigenvalue-based regression (Karpievitch, Bioinformatics 

2010), or flexible LOESS-based regression. 

 

In the Preprocess menu option, the linear regression method tries to fit a regression line 

for each dataset within a selected factor (ex. Replicate) against a reference (see 'Define 

Factors' for more information on factors).  We can choose various sets of data to regress 

other data against. “Mean of All Datasets” doesn’t require any factor/column metadata 

information, the others do.  

 

For the example data set, highlight the LogTransform_T_Data table in the Object 

Browser, then select Preprocess->Linear Regression. Click "OK" with the default options 

checked to run the transformation and produce the LR_LogTransform_T_Data table. 

 

Then run the Boxplots (see previous section) menu command to compare the average 

distribution. It should be clear that we have removed a systematic bias and made the data 

more symmetric. 

 

 



 
 

Boxplots. Left: first 8 data columns before normalization. Right: first 8 data columns 

after normalization. 

 

 

The 'Variance weighting' applies a mild weighting factor which assumes less intense data 

has somewhat higher variance. The particular functional form we assume is variance 

proportional to the 1/4 power of intensity, which has been found appropriate for our LC-

MS proteomic data. 

 

Other kinds of plots that can be done are histograms, Q-Q plots to check for normality, 

and heatmaps. 

 

Data Filtering 

 



 
 

We can filter datasets using either subsets of rows, columns, or linked metadata (see 

Metadata) – your table needs to be linked for metadata filtering. For this dialog, selecting 

a data frame, filter type, and a subset of items to exclude, will create a new table 

containing the filtered items.  

 

For the example data set, opening the Preprocess/Filter dialog, selecting T_Data by 

Column Metadata/Treatment allows only datasets that satisfy particular factor field 

criteria to be selected. Clicking "OK" produces a new table "Filter_T_Data" which can be 

treated the same way as T_Data was before and keeps its associated metadata. 



Peptide-to-Protein Rollup 

We'll now look at examples of performing large-scale statistical tests on our data set. We 

might be interested in seeing if the effect of treatment across a set of peptide intensities or 

gene intensities is statistically significant. A possible wrinkle is that we would expect 

peptides arising from the same protein to have a statistically similar effect, and DanteR 

allows this to be taken into account. 

 

One approach that has been taken for peptide and protein data is the 'rollup': a 

transformation is applied to a set of peptides to generate a single data set which can be 

tested for statistical differences between conditions. Note that this method correctly 

works only with log transformed data.   

 

 
 

For the example data set, go to Rollup/RRollup. For this method, a reference peptide 

which has the most presence across all the datasets, is chosen from the group of peptides 

that belong to a protein. If there are multiple candidates, the most abundant one is chosen. 

Then the ratios of peptide abundances with respect to the reference are computed (since 

the data is assumed to be in log scale, the differences are used) and their median is used 

as a scaling factor. Protein abundance is obtained as the median of the resulting peptide 

abundances. 

 

The options are as follows:  Minimum Presence of at least one Peptide for a Protein: 

Peptides that have too many missing values below this percentage are dropped.   

 

Exclude peptides from scaling if they are at least not present in this many datasets: 

Within a group of peptides for a specific protein, the ones that do not overlap well 

(controlled by this value) are not scaled but they are kept to calculate the final protein 

abundance.  

 



Include Single peptide/protein matches (i.e. 'One-Hit-Wonders'): Protein with only one 

observed peptide will be included in the final list of proteins. The rationale behind this is 

that if a particular protein may have only one peptide but it may be quite abundant and 

present throughout giving some strong confidence on the presence of the protein.  

 

If the plotting is enabled using the checkbox, the scaling results will be plotted for each 

peptide group as follows: 

  
 

 

The output of the RRollup function can be seen in the object browser. Notice that it's a 

list, an object containing data tables: the list can be clicked to show its contents, which 

are a table of peptide counts per protein (Count), a table of rolled up "virtual peptide 

intensities" (RolledUp), and the same table scaled to equal means (Scaled). The RolledUp 

peptide intensity table can then be used in statistical tests, as described next. 

 

 



 

 

 

Performing Statistical Tests on Data 

The Statistics/ANOVA dialog provides an interface to R's lm() and glm() functions, 

designed for large scale data sets. The general idea is to repeatedly perform a given 

statistical test for difference of means between treatment groups, for individual rows of 

the data, or groups of those rows. It can be thought of as a more general version of the t-

test. 

 

For the example data set, highlight the RolledUp table in the list output from the 

RRollup function above, and go to Statistics/ANOVA, or click the "omega". The 

ANOVA dialog will come up. We can perform a test for whether there's a significant 

difference between groups "A" and "B" in the factor field "D". To do this, select the "D" 

factor in "Available Factors" and move it to the "Choose Factors" box. The "Model 

Type" selector allows more advanced types of regressions to be done, and can be ignored 

here. 

 

The "First Factor Reference Level" determines what the control/baseline factor level is 

for the first factor selected in the ANOVA. The final "Formula" box should contain "D". 

Clicking OK will perform the ANOVA statistical test sequentially on every single row in 

the data table - this might take a moment. 

 



 
 

The output is in the following format:  for each statistical test done, we report 2 columns 

per combination of factor and factor levels.  The “est” refers to fold change estimate and 

“pval” refers to p-value. For example, for a simple A-B binary comparison, the output 

table would contain "B.est" and "B.pval". 

 

Since our data is log-transformed, the statistical effect size is a log fold change estimate. 

In other words, a value of -2 means the expression is 1/4 its value in the control group, a 

value of +3 means the expression is 8 times its value, and 0 means no change. For many 

experiments, we would expect the median log fold change out of a large number of genes 

or proteins to be around zero, and any systematic difference over many comparisons to 

reflect inter-run bias (Quackenbush, 2002). 

 



 
 

 

In a proteomic context, we might also wish to perform ANOVA on groups of peptides 

from the same protein. In this case, for the example data set, re-open the 

Statistics/ANOVA dialog and check "Do Protein-Level ANOVA", then select the field in 

"Protein field" which corresponds to the unique protein ID (MinOfORF here). 

Technically, for each protein, the algorithm splits the peptide data into blocks 

corresponding to proteins, and fits the linear model 

 

y_ijk = a + b_i + c_j + e_ijk (1) 

 

where y_ijk is the log-intensity of the i'th peptide, in the j'th treatment group, and the k'th 

replicate within that treatment group, with overall means a, peptide-level mean b_i, 

treatment group mean c_j, and residual error e_ijk (Karpievich, 2010). For each protein, 

the algorithm uses the top N peptides, ordered by the median intensity of each peptide, 

where N is defaulted to 5, to avoid contamination by large numbers of low-intensity, 

high-missingness peptides. 

 

The output when this computation is run is again a data table 

ANOVA_LR_LogT_T_Data, consisting of pairs of columns, each column corresponding 

to a treatment effect compared to the control (c_j in the model (1))  and its corresponding 

p-value. 

 

This approach can give more sensitivity than rolling up since averaging over peptides has 

the problem of "throwing data away" (technically, we lose degrees of freedom).  

For example, for a C Crescentus data set Rrollup “discovered” 17/1097 proteins 

differentially expressed compared to 181 using peptide-level ANOVA. 

 



Statistics/ANOVA: Protein-level ANOVA 

 

 
  

 

Volcano Plot 

 

We would often wish to look at the overall distribution of output of statistical tests, to 

give an idea for how many proteins or genes are significantly differentially expressed or 

regulated. To that end the "volcano plot" has become a standard tool - plotting the log 

fold change versus the log-p value. 

 

For the example data set, select the ANOVA output from the previous section, select 

Plot->Volcano Plot and select OK with the default settings. Volcano plots of the 

treatments will be generated. 

 



 
 

This will display volcano plots of the estimate-p-value pairs generated from statistical 

tests, using the 2-column format. Optionally, a p-value cutoff and a log-fold estimate 

magnitude cutoff can be set. A small display at the top shows the number of (1) positive 

and negatively regulated species that exceed the cutoff thresholds (2) total number of 

points shown, plus the number of rows plotted that were not displayed because data was 

missing (NA) - this is usually because for those species there was not enough data to 

perform the statistical test. By clicking "Pick Points" and drawing a volcano plot, the 

mouse pointer can be used to highlight and add row labels to points of interest, e.g. 

highly upexpressed proteins. To stop picking points, right click on the plot and select 

"Stop". 

 

P-value adjustment 

 

Multiple comparisons adjustment of statistical rest results occupies a prominent role in 

the bioinformatics literature since, as in the previous example, we often deal with 

hundreds or thousands of statistical tests done simultaneously, so a usual "reject p-values 

over 0.05" approach would guarantee many false positives. Many methods of choosing p-

value thresholds to control family-wise error rates or false positive rates have been 

discussed, DanteR allows the user to adjust p-values using some of these methods. 

 

 



 
 

For the example data set, the Statistics->P-value adjustment menu allows the user to 

adjust for multiple comparisons using standard methods.  Having performer a statistical 

test (in the above section), enter the ANOVA or other statistical test table into the data 

entry. The default Benjamini-Hochberg FDR correction will provide a constant false 

discovery rate adjustment to p-values, so a FDR corrected p-value reflects the overall 

probability of seeing a false positive in the results determined 'significant'. There are 

conditions for this being strictly true, such as independence of tests, which may not hold 

in practise. The output of this function creates a new table in the 2-column statistical 

output form, with adjusted P-values. 

 

Automatically generating summary report tables 

 

The final step in many typical 'reports' of statistically significant gene, protein or peptide 

expression is collating the output into a convenient tabular format, summarising 

significantly up-expressed and down-expressed entities. DanteR provides a facility to 

make this easier. 

 

For the example data set, the function 'Create tables of significant up/down' requires 

output from Statistics menu item (eg ANOVA) which be followed by P-value adjustment. 

This create tables containing significant up and down expressed items from statistical 

output.  There are also options to order data by effect size or p-value. 

Summary Table, the default, merges all tables into one table, containing lists of species, 

effect sizes and unlogged effect sizes, and summary counts. The output of this function 

can be pasted directly into a spreadsheet for a report, or exported via File/Save Table.  

 



 
 

 

Generating clustered heatmaps 

 

Quite often rather than using a statistical model we are interested in exploring the data 

visually. Clustering is the assignment of data objects into groups called clusters which 

reflect relative similarity. Clustering can be done with a predetermined number of clustes 

(K-means) or by recursively partitioning all objects into a tree-like structure related to 

their degree of similarity, or a dendrogram (hierarchical clustering).  

 

For the example data set, we can generate a heatmap (color-coded intensity graphic) with 

clustered rows or columns using the Explore/Clustering tool.  This requires a data 

crosstab with linked column metadata (factors). The resulting plot shows clusters in data 

and outputs a table containing row names and clusters. 

 



  

 
 

 

Principal Component Analysis (PCA)  

 

Another commonly used graphical data exploration technique is principal components 

analysis, in which sets of linear combinations of the data rows or columns are taken 

which maximize the variance of their components. These often reveal informative 

patterns in data. 

 



 
 

For the example data set, PCA can be performed by highlighting one of the log-

transformed data tables in the object browser and going to Explore/PCA. The options 

include plotting columns or rows, coloring by factor, interactive peak picking, and 

showing a 95% confidence ellipsoid. You can plot in 2-D, fixed 3-D or interactive 

(rotatable) 3-D. The principle axes can also be chosen. Typical example graphics are 

shown below for 2D and 3D PCA. 

 
 



With interactive peak picking enabled for the 2D display, click on a peak to show the 

label, and right-click and choose Stop to or do this from the menu to stop peak picking. 

 

3D-PCA settings 

  
 

For the PCA dialog, turn “3D” on for rotatable plot. With interactive peak picking turned 

on, click “Select3D” in window to show labels in complex data. Use "Take A Picture" for 

the Picture save option from 3D. 

 



Customizing DanteR with add-ons 

 

DanteR will let you incorporate your own R scripts in as menu items. If you create a 

small R script and a dialog, then put it as the sole file in a folder, change the Addons 

location under Addons->Change Addons Location to that folder location and hit 

“Refresh”, the additional menu item will be added to DanteR.  

 

See the Dialog Maker Help or ?run.dialog for details on using the RGtk2Extras dialog 

language. 

 

For example, this tiny R script will generate a menu item and dialog to create a matrix of 

normal variates of a given size. 

 

# R script 

# dialog specification for random.matrix 

# the 'title' element can also be omitted 

random.matrix.dialog = list(title = "Random Matrix", 

rows.integerItem = 3,  

cols.integerItem=3) 

 

# function to create matrix of normal variates 

random.matrix = function(rows, cols) matrix(rnorm(rows*cols), rows, cols) 

# End R script 

 

 
 

 



Exploring Data via Dynamic Row Plotting 

 

  
 

DanteR uses the crosslinking between data and metadata to allow deep exploration of 

crosstab row data via plotting line plots or heatmaps. 

 

The data you want to plot should be in the typical crosstab (numeric data rows/columns) 

format. The additional tables you can crosslink to your data are those which share row 

metadata with your data. 

The 'Field to form Groups from' can be filled with any row metadata field. When one is 

selected, the 'Choose Rows or Groups' list will update automatically with the choices of 

elements within that field.  

 

In our example data set, if you select LogT_T_Data and the MinOfORF field, you can 

then quickly search through line plots or heatmaps (under Choose Plot Type) for 

interesting patterns. You can choose a row metadata field to sort the groups using the 

'Order Groups By' selector. 

 

 



 
 

 
 

 

Crosslinking ANOVA output to your data 

 

This example shows how we can crosslink data sets to explore data in more powerful 

ways. For example, we might want to browse peptide data after a statistical test has been 

performed, looking at the output of the statistical test in the same place as we show the 

plot of peptide intensities. While this could be done in R or Excel, it would be time 

consuming and non-interactive. 

 

In our example, if you have performed protein-level ANOVA (see ANOVA section), 

open up Explore/Dynamic Row Plot. Then select the Mass Tag crosstab data set and 

under 'Choose More Tables to Link', check Crosslink to the statistical ANOVA result 

table. Under 'Group by' select protein (MinOfORF field), then 'Sort by' ANOVA p-value 

field, Sort Order: Descending to highlight proteins with low p-values.  

 

You can use the plot options to also display the p-value of the statistical test, or any other 

field value, on the displayed plot itself. 



The dialog options and resulting output are shown below. 

 
 

 
 

In a similar way, data can be clustered and plotted via output tables from a clustering 

operation (see Clustering), so abundance profiles of proteins or genes within empirically 

determined clusters can be plotted all at once. The Help file gives more details on this. 



 

Explore/Dynamic Row Plot/Create Field 

 

For exploring data and grouping or sorting by particular attributes, you may also want to 

form a new attribute from existing one. For example, you may want to sort a set of 

peptides by the average intensity per protein. By clicking the 'Create New Field', more 

options will come up that allow these operations to be performed. 

The table below outlines the concept of creating a new field 'Avg Sum A, B, C by prot' 

which grouped peptide data can then be sorted by. 

 

Peptide  ExpA  Exp B  Exp C  Prot  Sum Avg Sum A,B,C By Prot  

1  0.5 0.6 0.7 P1  1.8 2 

2  1.1 1.2 1.3 P1  3.6 2 

3  0.1 0.2 0.3 P1  0.6 2 

4  -1 -1.1 -0.9 P2  -3 -3 

 

Example: We want the Average  Sum By Prot of fields A, B and C 

 

Under the Explore/Dynamic Row Plots/Fields option we would use the following 

options: 

 

Use Values in A, B, C 

Aggregate Fields Using = SUM 

Aggregate Rows = TRUE 

Grouping By = Prot 

Using  = AVG 

 

Another Create Field example with ANOVA 

 

Say you did ANOVA on all peptides and want to show a count of significant peptides per 

protein 

In the Row Plot dialog, load your peptide crosstab and select the ANOVA output table to 

crosslink with 

In the New Field window, create a new field SigP using Values In = ANOVA.pval, 

Aggregate Fields = Value, True/False Filter = True, Expression = “<“, Value = 0.05 

Reopen the New Field window, create a new field SigPCount using Values In = SigP, 

Aggregate Fields = Value, Aggregate Rows = True, Grouping By = Prot, Using = 

COUNTIFTRUE 

In the Row Plot window, group by Prot and select SigPCount as a title field. 

Filter by = SigP to ONLY display significant peptides. 



References 

 

 

Callister, S. J., L. A. McCue, et al. (2008). "Comparative bacterial 

proteomics: analysis of the core genome concept." PLoS One 3(2): 

e1542. 

Gentleman, R. C., V. J. Carey, et al. (2004). "Bioconductor: open 

software development for computational biology and bioinformatics." 

Genome Biol 5(10): R80. 

Jolliffe, I. (2002). Principal Component Analysis. New York. 

Karpievitch, Y., J. Stanley, et al. (2009). "A statistical framework 

for protein quantitation in bottom-up MS-based proteomics." 

Bioinformatics 25(16): 2028-2034. 

Karpievitch, Y. V., T. Taverner, et al. (2009). "Normalization of peak 

intensities in bottom-up MS-based proteomics using singular value 

decomposition." Bioinformatics 25(19): 2573-2580. 

Kiebel, G. R., K. J. Auberry, et al. (2006). "PRISM: a data management 

system for high-throughput proteomics." Proteomics 6(6): 1783-1790. 

Lang, M. L. a. D. T. (2010). RGtk2: R bindings for Gtk 2.8.0 and above. 

Nesvizhskii, A. I. (2010). "A survey of computational methods and 

error rate estimation procedures for peptide and protein 

identification in shotgun nproteomics." J Proteomics 73(11): 

2092-2123. 

Oberg, A. L., D. W. Mahoney, et al. (2008). "Statistical analysis of 

relative labeled mass spectrometry data from complex samples using 

ANOVA." J Proteome Res 7(1): 225-233. 

Oberg, A. L. and O. Vitek (2009). "Statistical design of quantitative 

mass spectrometry-based proteomic experiments." J Proteome Res 8(5): 

2144-2156. 

Polpitiya, A. D., W. J. Qian, et al. (2008). "DAnTE: a statistical 

tool for quantitative analysis of -omics data." Bioinformatics 24(13): 

1556-1558. 

Quackenbush, J. (2002). "Microarray data normalization and 

transformation." Nat Genet 32 Suppl: 496-501. 

Taverner, T. (2010). RGtk2Extras R Package. 

Troyanskaya, O., M. Cantor, et al. (2001). "Missing value estimation 

methods for DNA microarrays." Bioinformatics 17(6): 520-525. 

Wang, G., W. W. Wu, et al. (2006). "Label-free protein quantification 

using LC-coupled ion trap or FT mass spectrometry: Reproducibility, 

linearity, and application with complex proteomes." J Proteome Res 

5(5): 1214-1223. 


